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N Class Schedule

¢ Dayl ¢ Day?
» Design Flow Over View » TimingAnalysis
» Prepare Data » Tria Route
» Getting Started » Power Analysis
» ImportingDesign » SRoute
» Specify Foorplan » NanoRoute
» Power Planning > Fill Filler
» Placement » Output Data
» Synthesize Clock Tree » DRC

> LVS
> extraction/nanosim
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Cell-Based Physical Design — SOC Encounter 3.2
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Prepare Data

& Gate-Level netlist (verilog)
& Physical Library (LEF)

€ TimingLibrary (LIB)

€ Timing constraints(sdc)

€ | O constraint
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Ef/ Preparing Data : gate-level netlist

Illll

@ If designing achip, 10 pads, power padsand Corner
pads should be added before the netlist isimported.

€ Make surethat thereis no “assign” statementand no
“*cdl*” cell nameinthe netlist.
» Use the synthesis command below to remove assign statement.
set boundary optimization

» Usethe synthesis commands beow to remove “*cell*” cdl name
define_name rules name rule —map {{ cell’}}
change _names —hierarchy —output name rule



{cio) Prepare Data: LEF
DER. -- Process Technology

Layers Design Rule Parasitic

AW = Net width Resistance

Net spacin :
®Contact Areap g Capacitance

Enclosure

. Wide metal
¢ vial slot
Antenna

Current density
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Prepare Data: LEF

-- APR technology

€ Unit

& Site

€ Routing pitch

@ Default direction
€ Viagenerate

& Viastack
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ilcic Prepare Data: LEF
-- APR technology : SITE
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VDD

VS

VDD

VSS
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A Prepare Data: LEF

anCIC)
k.,./ -- APR technology :
L routing pitch , default direction

sy B | o
D — |metall routing pitch
1t

Horizontal| Vertical
routing routing

metal2 routing pitch Metall M etal?

Metal3 M etal4
Metal5 Metal6

99—




i

fg.:'f‘c/ Prepare Data: LEF

pée. - APR technology : via generate

€ To connect wide metal , createaviaarray to
reduceviaresistance

& Definesformul asfor generating viaarrays

Layer Metall
DirectionHORIZONTAL
OVERHANGO0.2

Layer Metal2 EEEEE
Direction VERTICAL EENENN
OVERHANGO0.2

Layer Vial
RECT -0.14 -0.14 0.14 0.14
SPACING 0.56 BY 0.56

23



1 4

=c10) Prepare Data: LEF

DB, -- APR technology : via stack
Without via stack With via stack

€ Higher density routing
@ Easier usage of upper layer

€ Must Follow minimum arearule
24
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Prepare Data: LEF
-- APR technology : Physical Macros

@ Definephysical datafor
» Standard cdls
» |/O pads
» Memories
» other hard macros

@ describe abstract shape
> Size
» Class
> Pins
» Obstructions

25
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Prepare Data: LEF

pée=- APR technology : Physical Macr 0S cont.

MACRO ADD1
CLASS CORE ;

VDD

FOREIGN ADD1 0.0 0.0 ;
ORIGEN 0.0 0.0 ;

LEQ ADD ;

SIZE 19.8 BY 6.4 ;

N,
I

SYMMETRY XV ;
SITE coresite

PIN A

DIRECTION INPUT ;
A PORT

LAYER Metall ;

RECT 19.2 8.2 19.5 10.3

VSS

END
END ADD1
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i Prepare Data: LIB

i
Lo,

€ Operating condition
» dlow, fadt, typical
€ Pintype
> Input/output/inout
» function
» datalclock
» capacitance

@ Path delay

€ Timingconstraint
» setup, hold, mpwh, mpwl, recovery



==’ Prepare Data: Timing constraint

@ Create clock
€ |nput delay

€ Outputdelay
€ Inputdrive

4 Output loading
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cic) Prepare Data: Timing constraint
-- Create Clock

}
}

create _clock [-name cdock name]
-period period value
[-waveform edge list]
[clock source list]

20

\‘ / \ /I_CLK

10

create _clock —name CLK1 —period 20 —waveform {0 10} [get_ports|_ CLK]
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g.:“/ Prepare Data: Timing constraint
aTH S -- create generated clock

create_generated clock -add -master _clock

[-name clock_name]
[ CLK | : -source master_clock_root
- T [-multiply by mult]
| [-divide by div]
t [-duty cycledc]

DaN-—div clk | [-invert]
[-edges edge lit]
i [-edge_shift edge shift_list]

] clock_root_list

DF

create generated clock —name CLK2 —source[get_ports | CLK] —divide by 2[get pins DF/QN]

30



ii?r

g_c, Prepare Data: Timing constraint
--set_input_delay

[ |
-l

i

set_input_delay delay value
[-min]

CLK1 [-max]

—\ [-rise]
Inl..In7 ‘"‘"Xdelay [-fall]
[-clock clock _name]

[-clock _fall]

[-add delay]

[-network latency included]
[-source latency included]
port_pin list

set_input_delay 1 —clock [get _clocks{CLK1}] [getports{Inl}]
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g_c, Prepare Data: Timing constraint
--set_output_delay

[ |
-l

i

set_output delay delay value

[-min]
CLK1 r-max]
. delay [-rise]
Outl % [-fall]
[-clock clock_name]
[-add_delay]
LR [-network_latency included]
CLK1 ['SOUr(.:e_I atency | ncluded]
port_pin_list

set_output_delay 1 —clock [get_clocks{CLK1}] [getports {Outl}]
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QC.?E@ Prepar e Data: Timing constraint

pros --set_drive
Inl
set_drive [-min]
-max]
3,2,4,3 -rise]

In2 -fall]
drive_strength
port_list

rise_ min,rise_ max, fall_min, fall _max

set_drivel[get_ports{Inl}]



Q_@ Prepare Data: Timing constraint
DED. --set |oad

5f set_load [-min]
-max]

- -pin_load]
-wire load]
load value
- port_list

set_load 1[get_ports{Outl}]
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e’ PrepareData: 1O constraint

L
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€ Createan |/0 assignment file manualy using thefollowing template:

Version: 1

MicronPerUserUnit: value

Pin: pinName side |corner

Pad: padlnstanceName side|corner [cellName]
Offset: length

Skip:length

Spacing: length

Keepclear: side offsetl offset2

35



Prepare Data: 1O constraint con

Version: 1 >
Pad: CORNERO NW

Pad: PAD_CLK N
Pad: PAD_HALT N

CORNER1 4
Pad: CORNER1  NE
Pad: PAD X1 W
Pad: PAD X2 W

Pad: CORNER2  SW
Pad: PAD IOVDD1 S PAD_X1 PAD_VPD]
Pad: PAD_IOVSSL S

Pad: CORNER3  SE
Pad: PAD VDD1 E CORNER?2 CORNER3
Pad: PAD VSS1 E >
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|psto Reducethe Power/Ground Bounce

b
I:E

€ Don't use stronger output buffersthan what is necessary
€ Use dew-rate controlled outputs

@ Place power pad near the middle of the output buffer

@ Place noise sengitive 1/0 pads away from SSO 1/Os

@ Place VDD and VSS pads next to clock input buffer

€ Consider using double bonding on the same power pad to
reduceinductance
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Cadence On-Linedocument
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unix% /usr/cadence/ SOC/cur/tools/bin/cdsdoc &
— = unix% /usr/cadence/l C/cur/tools/bin/cdsdoc &
Active Library:

50C32 usticaence/SOCICur unix% /usr/cadence/L DV/cur/tool 5bin/cdsdoc &

Docs by Procluct | ,r|
_-'I-J-_'| BuildGates

23 CDSDOc € html browser mus be ingdled

_‘,"_|'_1 Cadence Shared Tools
ko Celtic

% 3 0r1 @ do not set the proxy in html browser

_-'I-J-_'| Install and License
_-llj-_'| Languages

_-||-_|-_'| RanoRoute

# T PKS

#F 7] 50T Encounter

Search el Exit
Search | |




=x(CIC) .
e Getting Started

i
L

€ Source the encounter environment:
unix% source /usr/cadence/cic_setup/soc.csh

€ Invoke soc encounter in 64 bit mode:
unix% encounter -64

€ Do not run in background mode. Because the terminal become the
Interface of command input while running soc encounter.
€ The Encounter readsthe following initialization files:
» SENCOUNTER/etc/enc.tcl
» .Jenc.icl
» .Jenc.pref.tcl
€ Logfile:
» encounter.log*
» encounter.cmd*
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N Tool Wedgits

Calculate
Zoom Hierarchy Fence Attribute Xwindow

Dwgnlmport Fit Pre\/lous Down/Up DenS|ty Edltor dump/undump

J JJJJHQ EJ JJ JJJ JJJ

Zoom Zoom Redraw Undo/Redo Desgn ‘
In/Out Select Browser Summary Report
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=:7010) . .
cH Design Views
~Views; & FloorplanView

DH / > displaysthe hierarchical module and block

guides,connection flight linesand floorplan objects

€ AmoebaView
» display the outline of modules after placement

= & Placement View
» display the detailed placements of cells, blocks.
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T

Common Used Bindkeys

q Edit attribute d popup Delete
f Fitsdisplay popup Edit
Z Zoomin T editTrim
Z Zoom out 0-9 View layer [0-9]
Arrows | pansdesign areainthe hierarchy up
direction of the arrow ¥ hierarchy down
Delete | Removesthelast ruler
xReovmaiies | Skrgmoctier
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lmport Design

[ ] |
) mp

Design »>Design | mport...

€ MaxTimingLibraries
» containing worst-case conditions for
setup-timeanalysis
€ MinTimingLibraries
» containing best-case conditions for
hold-time analysis
€ CommonTimingLibraries
» used in both setup and hold analysis
€ |OAssignment File:

» get alO assignment template:
Design 2Save21/O File...

Cresign lmport

e ey, L LY,
1
1

exporhomenschangiorkS5 00

Sywefcie

leffumc 18 _BIm_cic bef lafumc 18ia

IWDPRES:1 B _shonw_synlib livsle
liWDPREL:16_fast_synlib libTast
liDIPRGL: 6 _typical_syn.lib lis'h




aa CIC) .
b Import Design cont

€ Buffer Name/Footprint:
» gpecifiesthe buffer cell family to be inserted or swapped.

@ Delay Name/Footprint: For Ce“SiBUFXL
> required to run afix hold time violation BUEX1
€ |nverter Name/Footprint: SBE%
» required to run IPO and TD placement. BUEX4
@ Get footprint of library cellsby: BUF><82
. . BUFX1
» Timing->Report>Cdl Footprint BUEX16
BUFX20
Footprint : buf
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Import Design -- Timing

}
|y

S
(§=
3,

Lrasign lport

» Netswith terminal counts greater than
| the specified value are assigned the
default net delay and net load entries.

¢ Default Net Delay:
» Set the delay values for a net that
meetsthe pin limit default.

& Default Net Load:
» Set the load for anet that meets the
pinlimit default.

e I_ & Input Transition Dday:
» Set the Primary inputs and clock nets.
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i lmport Design -- Power

€ Specify the names of Power Nets and Ground Nets

tesign Import

I.‘-'—'-'—'-'—'—I..—.f—'—'—'—'—'—'—n
(VDD OVDD
GHD DGND

10

Tosge aescafacr [ e |
—




PIN:*.vDD:Module(]
PIM:* GHD:Madule()
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Specity Floorplan

ﬁ&f_?? Specify Floorplan

Floorplan=2>Specify Floorplan ...

A

D Hight 0o na 1255.617 125112
19413 18449 1060.717 105622

27522 27446 mony arL5e

=N

)

< width >




..ﬁ%peufy Floor plan — Doube back rows

Illll
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ss(CIC)
Place Blocks

€ automatic place blocks ( blackboxes
and partitions) and hard macros at the

top-level design.
& Block halo

» Specifies the minimum amount of
space around blocks that is preserved

for routing.




A Manually Place Block

i
L

o & Move/Resize/Reshape floorplan object.

€ Usefunctionsin : Floorplan 2Edit Floorplan to
ed|t floorpla‘l. Align Instances...

3hift Instances...

Space Instances...
FlipfRotate Instances...

Snap Floorplan...

Legalize Floorplan...

Set Block Placement Status...

€ Set placement gatus of all pre-placed block to
preplaced in order to avoid these blocks be moved
by amoebaP ace | ater.

€ Floorplan=Edit Floorplan 2Set Block Placement
Status...
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Add Halo To Block

}
|y

€

e

Floorplan-Edit Block Halo...

€ Prevent the placement of blocks and standard cdlls in order to reduce
congestion around a block. Edit Block Halo
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iy Block Placement

& Flow step
» |/0O pre-placed
» Run quick block placement I I
» Throw away gandard cell
placement
» Manudly fit blocks

@ Block placeissue
» power issue
» noiseissue
» routeissue
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el Block Placement

-.'_'.'ﬂ,.——--

€ Preserve enough power pad

€ Create power rings around block

@ Follow default routing direction rule

€ Reserve arounded core row areafor placer

|:>><
block

Default direction
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Use wire group to avoid
dot DRC error
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v'Usewiregroup
no interleaving
v'number of bits=2

Lf_fg Power Planning: Wire Group

v'Usewiregroup
vinterleaving
v'number of bits=2
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'=&--) Power Planning: Block Ring cont

iy
Ldald.
S
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&(39 Power Planning: Add Stripes
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&fi.@ Edit Route

Duplicate wire der than max width

AT o [ Esa]

Changelayer | gyjit'wire \ Trim wire lear DRC markers

Changewidth Mergewire Ddete wire o



EEEL) Edit Route cont.

M
. Edit Route
MoveWire
Add Wire

Cut Wire =/ 8| 1 == X Al
Stretch Wire Ea]) =)
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N Placement
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Place->Place...
€ Prototyping : Runs quickly, but components may not be placed at legal

location.
€ TimingDriven:
» Buildtiming graph beforeplace. | Placement Efiort Level

: . : “* Prototyping

» Mmeeting setup timing constraints - Low Effort
with routability. + Medium Effort

- High Effort

> Limited IPO by
upsi zeing/downsi zing instances.

I Timing Driven
= CHIP.post_tdp.v El
€ |gnore Scan Connection | Ignore Scan Connection

_I lgnore Spare Cell Connection
ol Save Placement to :CHIF.place [l

oK | Cancel | Help |

» nhets connected to either the
scan-in or scan-out are ignored.

€ Check placement after placed
» place=>Check Placement
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Floor plan Purposes

€ Develop early physical layout to ensure design objective can be

archived
> Minimum areafor low cost

» Minimum congestion for design routable
» Estimate parasitic for delay calculation
» Analysispower for reliability

€ gain early visibility intoimplementation issues

66
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Guide, Region, Fence

BYES
L
T

S

&€ Placementconstraint
@ Create guide for timing issue

@ A critical path should not through

two different modules Nyl

€ The moreregion, the more . NN

complicated floorplanning




Difference Floorplan
Differ encePerformance




o Wire L oad After Placement

L

[Hima

i

AL

Logical wire load after placement
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M odule Constraint

& Soft Guide ‘
& Guide

€ Region Soft Guide Guide

@ Fence
e e

Region Fence

}
}
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i Specify Scan Chain

FRiin
oL,
-._-.. —

encounter > gspecifyScanChain scanChainName
—start {ftname | instPinName}
—gop {ftname | instPinName}

€ Specifiesascan chainin adesign. The actud tracing of the scan chain
Is performed by the scanTrace or scanReorder command

€ ftname
» The design input/output pin name

€ instPinName
» The design instance input/output pin name

71



Scan Chain Reorder

-
L.

| ]
:Er:"r

€ No Skip

> Buffers and inverters remain after the scan chain reorder

€ Skip Buffer

» lgnores buffersin the scan chain.

€ Skit Two Pin Céll
» lgnores buffers and inverters in the scan chain

12



{‘Ef/ Clock Problem

@ Clock problem
» Heavy clock net loading
» Long clock insertion delay
» Clock skew
» Skew across clocks
» Clock to signal coupling effect
» Clock is power hungry
» Electromigration on clock net

€ Solutions of these problems may be conflict

@ Clock isone of the most important treasurein achip, do
not take it as other use.
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N Synthesize Clock Tree

Create Clock Tree Spec

1 |

Specify Clock Tree

1 |

SynthesisClock Tree

1 |

Display Clock Tree
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Create Clock Tree Spec.

Clock =Create Clock Tree Spec

Create Clock Tree Spec

Buffer Foaotprint; clkbuf
\/Inuerter Footprint: clkiny

|— Create Clock Tree Specification

Save Spec To:f CHIP.ctstcH

ok | apply | cancel | merp
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e’ CTS

& CTStracesthe clock starting from aroot pin, and stops at:
» A clock pin
» A D-input pin
» An instance without atiming arc
> A user-specified leaf pin or excluded pin
€ WriteaCTS spec. template:
» specifyClockTree -template

7
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#19 CTS spec.

FRiin
Lo,
= ——

€ A CTS spec. contain thefollowing information.
» Timing constraint file (optiona)
» Naming attributes (optiona)
» Macro model data (optiona)
» Clock grouping data (optiond)
» Attributes used by NanoRoute routing solution (optional)
» Requirement for manua CTS or utomatic,gated CTS

78



{cro) CTS spec.
o --Naming Attributes Section

€ TimingConstraintFile filename
» define atiming constraint file for useduring CTS

€ NameDdimiter dalimiter

» name delimiter used when inserting buffers and updating clock
root and net names.

» NameDelimiter # =2 create names clk##L 3#2
> default = clk L3 12
€ UseSingleDdim YESNO
> YES=> cdk L3 12
» NO = dk_ L3 12 (default)

79



HED, CTS Spec.

e -- NanoRoute Attribute Section

€ RouteTypeName name
RouteTypeName CK1

END
€ NonDefaultRule ruleName
> Specify LEF NONDEFAUL TRULE to be used

@ PreferredExtraSpace [ 0-3]
» add space around clock wires

€ Shielding PGNetName

» Defines the power and ground net names

80



pos, CTS Spec.

éif.m -- Macro Model Data Section
- -- Clock Grouping Section
€ MacroMode

» MacroMode port R64x16/clk 90ps 80ps 90ps 80ps 17pf
» MacroMode pin raml/clk 90ps 80ps 90ps 80ps 17pf
» dedlay and capacitance value:

maxRise mnRise maxFall minFall inputCap

& ClkGroup

» Specifiestow or more clock domains for which youwant CTS
to balance the skew.

» ClkGroup
+ clockRootPinNamel
+ clockRootPi nName2

81



@ CTS Spec.

oge~-M anually Define Clock Tree Topology

ClockNetName netName

LevelNumber number
> Specify the clock treelevel number

LevelSpec levelNumber number OfBuffers buffer Type

» |leve Number

v" Specify the level number in the clock tree
» number OfBuffer

v the total number of buffers CTS should allow on the specified level
» Example:

Level Spec 1 2 CLKBUFX2

Level Spec 2 2 CLKBUFX2

End
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i) CTS Spec.

oge.  -- Automatic Gated CTS Section

{

€ AutoCTSRootPin clockRootPinName
€& MaxDelay number{ns|ps}
€ MinDelay number{ns|ps}

€ SinkMaxTran number{ns|ps}
» maximum input transition time for sinks(clock pins)

€ BufMaxTran number{ng|ps}
» maximum input transition time for buffers (defalut 400)

€& MaxSkew number{ng|ps}



o CTS Spec.

péa. -- Automatic Gated CTS Section cont.

€ NoGating {rising|falling|NO}
» rising : stopstracing through a gate(include buffers and inverters) and
treats the gate as arising-edge-triggered flip-flop clock pin.

» falling: stops tracing through a gate(include buffers and inverters) and
treats the gate as afalling-edge-triggered flip-flop clock pin.

» No: Allows CTSto trace through clock gating logic. (default)

& AddDriverCdl driver cell name e 3%

» Place adriver cell at the cloest possible
location to the clock port location . |

Ep




i

22(CIC) CTS Spec.
oén. - Automatic Gated CTS Section cont.

o,

P

i En-l

€ MaxDepth number
€ RouteType routeTypeName

@ RouteClkNet YEJNO
» Specifies whether CTS routes clock nets.
€ PostOpt YESNO

» whether CTSresizesbuffersof inverters, refines placement,and
corrects routing for signal and clock wires.

> default YES
& Buffer cdll cdl2 cdl3 ...

» Specifiesthe names of buffer cellsto use during CTS.
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péa. -- Automatic Gated CTS Section cont.

€ LeafPin
+ pinName rising|falling

» Mark the pin as a“leaf” pin for non-clock-type instances.

> LeafPin
+ instancel/A rising i_

+ instance2/A rising A&'

& LeafPort Acg
+ portName rising|faling B

» Mark the port as a“leaf” port for non-clock-type instances

86



@9 CTS Spec.
e -- Automatic Gated CTS Section cont.

@ ExcludedPin I -
+ pinName > >—’f.
+ ... .
€ ExcludedPort >
+ portName -
+ > -

» Treatsthe port as a non-leaf port, and preventstracing and skew
anaysis of the pin.

87



@9 CTS Spec.

f A
€ ThroughPin p } . D iz
+ pinName * ___________ Ap

R A S
» Traces through the pin, even it the pinisaclock pin

A s
& PresarvePin 1 """""" S
+ inputPinName } } """" M """""" Preserve

» Preservethe netlist for the pin and pins beow the pininthe
clock tree.



z(cIC) CTS Spec.
oén. -- Automatic Gated CTS Section cont.

-

& DefaultMaxCap capvalue

» CTSadheresto the following priority when using maximum
capacitance value:

v MaxCap statements in the clock tree specification file

v DefaultMaxCap statement in the clock tree specification file
v Maximum capacitance valuesin the SDC file

v maximum capacitance valuesin the .lib file

€ MaxCap
+ buffer Namel capValuel{ pf|ff}

+ bufferName2 capVal ue2{ pf|ff}
+ ...

» Buffer should be inserted if the given capacitance value is exceeded

89



1oot CIs

T=e

Reconver gence clock

Tootl
root? |

Crossover clock

CTS
Tree
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Clock Synthesisreport

€ Summary report and detail report
» number of sub trees
» rise/fall insertion delay
» trigger edge skew
> riseffall skew
» buffer and clock pin transition time

» detailed dday ranges for all buffers add to clocks

@ Clock nets
» Savesthe generated clock nets
» used to guide clock net routing

@ Clock routing guide
» Savesthe clock tree routing data
» used as preroute guide whilerunning Trial Route
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(cro) Display Clock Tree
DD --by phase dday




==1CI0)
e Clock TreeBrowser
Clock =Clock Tree Brower

Clock Tree Browser: PAD_CLK/Y
Browser Edit Display Report

tree instance_name | input_delay (p
= TREE
BT CLKIMYX20 A CLE__L1_10 [
Bz CLKINYX20 A CLE__ Lz [323.3 320.7]
3 CLEBUF<z0 A& CLK__ L3 113 [701.7 705.5]
4 ZDFFTEX1 CK. DCT/hdeg/ACC0/aces_reg B [963.4 980.8]
[
[
I

37.3 37.3]

45DFFTRX1 CK  DCT/hdeg/ACCH/aceS reg 5 [963.3 980.7]
963.1 990.5]

aEn =2 a7ve 7l

45DFFTRAT CK DCT/bdegfACCDYaces_reg_4_

A SMEETEY 1 ™k Cir Tl hdan! AT arerS ran 2

€ Display trig edge, rise/fall delay, rise/fall skew, input dday,
Input tran of each cell.

& Resize/Deleteleaf cdl or clock buffer

€ Reconnect clock tree
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¢ IPO
» setuptime
» hold time

» DRV (Design
Rule Violation)




=2l ~0) _ .
i Congestion Optimization

i
T —

encounter > congOpt
[ -nriterlnCongOpt nriter |
[ -maxCPUTimel nCongOpt time |

€ Reduces congestion after placement in an iterative way.

& Parametars

» nriterinCongOpt nriter

v' Specifiesthetotal number of iteration in congestion optimization.
(default 1)

» maxCPUTimelnCongOpt
v’ specifiesthe maximum CPU time in congestion optimization,in hours.
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==CIC)
N Balance Slew

i
Lo e
T g

encounter > balanceSew
[ -selNetFile selNetFileName |
[ -excNetFile excNetFileName |

@ Speeds up or Slowsdown thetransitiontimeif it is greater
or lessthan the specified maximum transition time.

& Parametars

> selNetFile sdNetFileName

v’ Specifiesth file that contains the hierarchical net names that are
excluded from the 1PO pperation

> excNetFile excNetFileName

v Specifiesthe file that contains the hierarchical net (path) names for
the 1PO operations. Only these net names are considered.
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)
. L
3

Useful Skew

}

{%5

encounter > setAnalysisMode -useful Skew

encounter > skewClock

encounter > optCritPath

!__J los

i 10ns

balanced clock

9



@ perform quick routing for congestion and parasitics

estimation
€ Prototyping:
» Quickly to gauge the
feasibility of netlist.
» componentsindesign might
no be routed at legal location

=21C10) .
N Trial Route

Trial Route

— Trial Route Effort Level
<~ Prototyping

~ Low Effort

~» Medium Effort

-~ High Effort

1 Use Routing Guide (CHIP.guide

1 Save Routing to :CHIF route
I lgnore Routing Obstruct
I Handle Partition

hax Route Layer & — |

0K Cancel |

Help |
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B
5

Trial Route Congestion Marker

(e
1EE;

@ visually check thecongestion
statistics.

€ dump congestion area:

» dumpCongesArea -all file_ name

Thevertical (V) overflow is 25/20 (25 tracks are required , but only 20 tracks are available) .
The Horizontal (H) overflow is 16/18 (16 tracks are required , and18 tracks areavailable) .
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IC)

5’ Trial Route Congestion Marker con

il
L T
=

Level Color Overflow Vaue
1 ® Blue One moretrack required
2 Green Two moretrack required
3 Ydlow Three more track required
4 ® Red Four more track required
5 ® Magenta Five more track required
6 and higher | ® Grey to White | Six or moretrack required
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N Timing Analysis

Timing-=>Specify Analysis Condition 2>Specify RC Extraction Mode ...

T| ml ng 9Extract RC . _ Timing Analysis
Timing=>Timing Analysis...

€ No Async/Async:

» recovery, removal check

€ No Skew/Skew:

> check with/without clock
skew constraint




Slack Browser

Timing-=>Timing Debug->3ack Browser ...

Analysis mode: —setup —skew —caseAnalysis —async —clkSrcPath
Format; clock timeReq slackRislackF setupFisetupF instMame/pintame # cycle(s)
CLEKA{F)-=CLK1({R) 21.000 1.500/1.500  ** O Z[2] 1
CLEA(F)—=CLEA(R) £1.000 1.928/1.928 %™ O _Z[0] 1
CLEA(F)—=CLEA(R) Z£1.000 Z.058/z.05z2 %™ O Z[1] 1
CLEA{R)-=CLK1(F) 11662 Z.1B7/Z167  */* DCT/posemem/Bisted DPRE4x16/BistCtr
CLEA(F)—=CLEA(R) £1.000 Z.568/2.868 %™ 0 _Z[B] 1
CLEA(F)—=CLEA(R) £1.000 ZE19/2.619 %™ O Z[4) 1
CLEA{F)-=CLK1{R) 21,000 ZEB77ZE7F ** O _Z[0] 1
CLEA(F)—=CLEA(R) £1.000 Z.E30/Z.680 %™ O 2[4 1
CLEAF)—=CLEA(R) Z£1.000 Z.E38/z.688 ™ O Z[11] 1
Em IR A WA o TRt W m B R e R e e E gk e
IN |
Sort By, Original —-| Find InstFin MName;
Cancel | Help |
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Timing-=Extract RC...
Power -Edit Pad Location...
Power -Edit Net Toggle Probability...

Edit Net Toggle Probability

545.440000 31.680000 b5 PAD_CorevDD3
31.630000 BE=.920000 b5 PAD_CoreVDDZ
785.800000 1213.440000 t5 PAD CoreVDDN
Bz5.560000 31.680000 b5 PAD Corevs353
31.630000 346.040000 b5 PAD_CoreW3sE
865920000 1213.440000 tE PAD CoreVssi

CLK1 50000 0.900




Power 2Power Analysis->Statistical .

€ analysisreport:
> A power graph
» report contains
v’ average power usage
v worst IR drop
v worst EM violation

» instance power file
» instancevoltagefile
» boundary voltagefile




Power Analysis Simulation—Based

Simlation-Based
Power Analysis

Power 2Power Analysis=>
Smulation-Based

€ savenetlist for smulation
» Design>Save->Netlist. ..

€ simulation and dump vcd file.
» $dumpvars;
> $dumpfile(*wave.vced”);

€ Input ved file for power
andysis
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22(CIC) _
b Display IR Drop
Power =2Display=Display IR Drop...

— Display Power/Ground MNet
Met MName: GMD
Threshold: 0.001

P 1

kAZ

Pl 3

Pl

hAS

B EE EE

Apply | Cancel | Help |




= @ ER
"

Display Electron Migration

Power =2Display2Display EM...
= S—HE | Dipayim

I 1 ~ Display Power/Ground MNet
————————— H [ v GND
: Layer Reset | Limit Lnit
I el 1 1 AU
I b2 1 m AU
I b3 1 m AU
I (ES B AU
I M5 1 maAfu
[ W12 | 1 rnAfout
I WEd | rnAfout
I W34 | i1 maAfcut
I Va5 | i1 maAfcut
ok | sy | cancet | e
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SRoute

8’
h-.-_
"E )

» Block pins
» Pad pins

» Padrings

» Standard cdl pins
» Stripes (unconnected)




N Add 1O filler

addloFiller —cell PFILL —prefix IOFILLER

addloFiller —cell PFILL_9 —prefix IOFILLER

addloFiller —cell PFILL_1 —prefix IOFILLER

addloFiller —cell PFILL_01 —prefix IOFILLER -fillAnyGap

€ Connect io pad power bus by inserting 1O filler.
€ Add fromwider filler to narrower filler.

=====

YADD O FILLER
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N Add 10 filler cn

FRiin
Lo,
= ——

& In order to avoid DRC error

» Theseguenceof placing fillers must befrom wider fillersto
narrower ones.

» Only the smallest filler can use -fill AnyGap option.

A gap that unable to place any filler
||

fill any gap —
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NanoRoute

Route-NanoRoute

WilEe

"
{

‘il




:ss

LR

NanoRoute Attributes

)
]

£

Route->NanoRoute/Attributes

ManoRoute/Attri butes




hY
A

asCIC
FEhr” Crosstalk

i
L L
e

Crosstalk problem are getting more seriousin 0.25um and

below for:
Smallerpitches
Greater height/widthratio

Higher designfrequency

A
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iifc}c\‘e
:j Crosstalk Problem

& Delayproblem ~ A997essor
origi n-al S -a-
| mpact ed--s ?\j/a'

€ Noiseproblem Aggr essor
origi nal S-t--g-1-a-

: A4
i mpact et {-3-—r---g--ﬂ--axiK ....................... -
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el Crosstalk Prevention
€ Placementsolution D >
» Insert buffer inlines Add buffer
» Upsizedriver D |
» Congestion optimization M Upsize >
-

€ Routingsolution
» Limit length of paralld nets |
> Wider routing grid ‘
» Shield secid nets
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Antenna Effect

€ |n achip manufacturing process, Metal isinitially deposited
S0 it coversthe entire chip.

€ Then, the unneeded portions of the metal are removed by
etching, typically in plasma(charged particles).

€ The exposed metal collect charge from plasmaand form
voltagepotential.

@ If the voltage potential acrossthe gate oxide becomeslarge
enough, the current can damage the gate oxide.
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DB Antenna Ratio

Plasma

metal2  Plasma

via metall
] ] ]

poly gate oxide=——

Area of process antennas on a node

Antenna Ratio =
Area of gates to the node
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el Antenna Problem Repair

e

€ Add jumper
€ Add antennacell (diode)
€ Add buffer

metal2

vial metall
poly
gate oxide

o T




o Add CoreFiller

Place-=>Filler 2Add Filler...

€ Connect the NWELL/PWELL layer in core rows.
€ Insert Well contact.
€ Addfromwider filler to narrower filler.
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5:(CI0)
N

Add bondi ng padS (stagger 10 padsonly)

Linear |1 O pad Stagger | O pad
Abutted Stagger 1O

NN

PI N

§ oqi
\
Bondin

AL

122



i
4

(CIC)

O

Add bondi ng padS (stagger 10 padsonly)

i
1 I s
e

€ For the limitation of bonding wiretechnique, the stagger 1O
pads are used in order to reduce 10 pad width.

€ \We haveto add the bonding pads after APR isfinishedif
stagger 10 padsis used. But SE does not provide abuilt-in
function for add bonding pads, CIC reachesthis purpose by
the way of importing DEF.

& CIC providesa perl script to calculate the bonding pad
location. The full flow isdescribed in next page
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Add bondi ng padeIOW (stagger 10 padsonly)




i Output Data

Design 2>Save->GDS...
Design 2Save->Netlist...
Design 2>Save->DEF

€ Export GDSfor DRC,LVS,LPE,and tape out.
€ Export Netlist for LVSand simulation.
@ Export DEF for reordered scan chain.
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Post-L ayout Verification —
DRC/ERC/LVS/LPE



2C10) e .
o’ Post-L ayout Verification Overview

@ Post-Layout Verification do thefollowing things:
» DRC ( Design Rule Check )
» ERC (Electricd Rule Check )
» LVS (Layout versus Schematic)

» LPE/PRE (Layout Parasitic Extraction/ Parasitic Resistance
Extraction) and Pog-Layout Simulation.

127



H

s’ Post-L ayout Verification Overview cont.

AL

DRC LVS
vdd!
i — —— zn comparewith i = T m
BEERER L L
0O 1 2 3 N gndt
ERC
vdd! clk




.|{

=>—"Post-L ayout Verification Overview

Schematic Netli st

DRC [ Extract Devices } ] ) ’ optional
k',// L’/
{ ] { { ] Extracted Netlist with
ERC LVS L PE/PRE = e

Text and Graphical Error Reports

{ Post-Layout Simulation }

129



o DRC flow

& PrepareLayout
» Streamin gds2
» add power pad text
» Stream out gds2

@ Prepare command file
€ run DRC
€ View DRC error (DRC summary/RVE)
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BEREE!
J

e

iy
LAE L~
T

Prepare Layout
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@ Prepare Layout: Stream In GDSl|

FAiin
L
i

€ Require:
» technology file
> display.drf

@ File->import->stream

Virtuoso® Stream In
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@ PreparelLayout: Add Power Text

iR

€ Add power text for LVS and Nanosim

€ For UMC18/artisan library
» Addtext DVDD for IO power pad
» Addtext DGND for 10 ground pad
» Addtext VDD for core power pad
» Addtext GND for core ground pad



& File->Export->stream..

Virtuoso® Stream Out

@ PrepareLayout: Stream Out GDSI |
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hY

[ci0) .
e Prepar e command file

i
Lad b
g

€ Prepare DRC Command file:

» 0.18 (CBDK018 UMC Artisan) Calibre
v/ 180nm_layers.cal
v' G-DF-IXEMODE_RCMO0S18-1.8V-3.3V-1P6M-MMC-Cdlibre-drc-2.2-pl

135



..r

i’ Prepare Calibre Command file

=)

& Edit runst file

LAYOUT PATH “CHIP.gds2”
LAYOUT PRIMARY “CHIP”
LAYOUT SYSTEM GDSII

DRC SELECT CHECK
NW W 1
NW W 2

DRC UNSELECT CHECK
NW.S. 1Y
NW.S. 2V

DRC ICSTATION YES
INCLUDE ““Calibre-drc-cur”
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N Submit Calibre Job

i
LogiLe,

€ Submit Calibre Job
» caibre —drc umcl18DRC.cd

€ Reaultlog
» CHIP.drc.summary (ASCII result)
» CHIP.drc.results (Graphic result)
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Ef/ Using Calibre RVE

& Addin .cdsinit

setSkillPath(“. ~/ /usr/memtor/Calibre ss/cur/shared/pkgs/icb/tools/queryskl”)
load(“calibre.skl”)
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-\ Using Calibre RVE

Viruoso® Layout Edifing: CHIF CHIP layout

Sk imer s {F) Smisct: @ o ity st e T -
Teoh Dwiigs Wndew Ousts EgA Yty Comscivity Options
& Fun DRC
d | Foun LVS ,
e IBR
RVE
% Clear Wghlihts 'A
& il k Satup VISUALIZATION
| i 0 * About Calibre...
L I S R R i] e e |
| L |
o oA LM .
q- T J 1 I i | I ll | = e
: o . [
: HEE A4 1 R [ ¥ Open Calibre DB _I
rd = ] ASE
| :r-'t"' i B = = D\
f"‘.l. o = j JDRCrdrc.dh } | Emwse...l
H:l,t R R i F —
it — Database Type
&. # DRC/ERC -, LV¥S - SPICE File
™ s
_1 Use Calibre-CB license |
Q| 8
o] 0K Cancel | Tum On Query Help |
Q.
o oo LR 1w _salibes e s 139




- Using Calibre RVE

Calibre — DRC RVE : drc.db

Hle Mew Highlight Setup ﬂelpl
E » 4 H » Z |
& cell T
E.aﬂﬂhmrsmlﬂuflﬂmecks} iy v o ~
—| B Cell CHIP - 13126 Ervors 4-Yertex Polygon
Check 4.1G.a - 1000 Exrors (CHIF coordinates)
Check 4.2B.a_F - 33 Exxors -301.31 , -857.24
-301.27 , -257.24
01 02 03 04 05 06 07 08 09 10 e e
[11]12 13 14 15 16 17 18 19 20 Il =301 31 | 954,83
21 22 23 24 25 26 27 28 29 30
12 B

Check 4.14G - 1000 Ervors
Check 4.16C.a - 1000 Exvors
Check 4.16C.b - 510 Exrors
Check 4.16D b - 1000 Exrors
H k= |iE |"~l 1= _f
— Checktext

Eule File Pathnsme: G-DF-MIXEMODE RFCMOS18-1.8V-3. 3V-1PeM-MMCG-Calibre-drc-2. 2-pl
Minimum N-Well to N-Well spacing for equal-potential is 0.9

= = 7

Cell CHIP [Check 4.2B.a_F] : 11 of 33 Ernrors |i




HER
N

Layout Data

VDDcdk rst cin sel GNDVDD

LVS Overview

a<0>

1>

ax<2>

3>

4>

a<5>

AN nA

uudduddud

VDD

b<0>
b<1>
b<2>
b<3>
b<4>
b<5>
gnd!

a<5.0>

b<5:0>
clk
rst

cin

Schematic Netlist

1

141

s<5:0>

— carry



HER " .
=i’ Initial Correspondence Points

i
L
=

@ Initia correspondence points establish astarting place for
layout and schematic comparison.

& Createinitia correspondence node pairs by
» adding text grings on layout database.

» al pinsinthetop of schematic netlist will betreated as an initial
corregponding nodeif calibre finds atext string in layout which
matches the node name in schematic.

VDD global pin: VDD and GND

- 0> D >D
a<0>7 b<0> D—
b<0>‘\< initial corresponding

nodepairs
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N, Black-Box LVS

Calibre black-box LVS
» Onetypeof hierarchicd LVS.
» Black-box LV Streatsevery library cdl as ablack box.

» Black-box LV S checks only the interconnections between library
cellsin your design, but not cdl inside.

» Y ou need not know the detail layout of every library cdls.
» Reduce CPU time.
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Egi‘ﬁ%ck-Box LVSvs. Transistor-Level LVS

e dy
iiin
.

Transistor Level LVS |

VDD .
—E
1 . i1"‘__+t: |
5 vs. ,
I 12
GND
=

Black-Box LVS

%

nd02d1

VDD
invod1 nd02d1 i1 —D@— -
100 O| o P P

VS.

GND




LV Sflow

@ PrepareLayout
» The same as DRC Prepare Layout

& Prepare Netlist
> v2lvs

@ Prepare calibre command file
€ runcaibre LVS
€ View LVSerror (LVS summary/RVE)

145



i’ PrepareNetlist for CalibreLVS

Prepar e Netlist

umcl8lvs.v

umcl8lvs.spi

CHIP.5pi

4 \(/32Ivs —v CHIP.v - umci8lvs.v —0 CHIP.spi —s umc18lvs.spi —s1 VDD —s0
ND
|f a macro DRAM64x16 isused
€ Vv2lvs—v CHIP.v - umci18lvs.v —| DRAM64x16.v —0 CHIP.spi —s
umcl8lvs.spi —s DRAM64x16.5pi —s1 VDD —s0 GND i



i CIC Supported Files .s)

FRiin
oL,
-._-.. —

4 E_I C supportsthefollowing filesin our cell library design
IT.
» Calibre LVSruns¢ file
umcl8LVS.ca

» Cdibre LVSrulefile

G-DF-MIXEDMODE_RFCMOS18-1.8V_3.3V-1P6M-MMC-
CALIBRE-LVS-1.2-P3.txt

» Black-box LVSrelaivefiles
v’ pseudo spicefile
umcl8LVS.spi

v’ pseudo verilog file
umcl8LVSyv
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N Black Box related file

€ Pseudo spicefile
.GLOBAL VDD VSS
SUBCKT AN2D1Z A1 A2VDD GND

.ENDS

€ Pseudo verilog file
module AN2D1 (Z, A1, A2);
output Z;
input Al;
input A2;
endmodule

148



éig&repare command filefor CalibreLVS

iy
[

& Edit Calibre LV S runset

LAYOUT PATH “CHIP.calibre._gds”
LAYOUT PIMARY “CHIP”
LAYOUT SYSTEM GDSII
SOURCE PATH “CHIP.spi”
SOURCE PRIMARY *““CHIP”

INCLUDE ““/calibre/LVS/Calibre-1lvs-cur”

& Edit CalibreLVSrulefile

LVS BOX PVSSC
LVS BOX PVSSR
LVS BOX DRAM64x4s
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HN Submit Calibre LVS

& calibre —lvs —spice layout.spi —hier —auto
umcl8LVScal > lvslog

layout verilog

layout .spi <:> CHIP.si




‘(fi-(/ Check CalibreLVS Summary

I'I.lll
-.'_'-...-

4 OVERALL COMPAISON RESULTS
4 CELL SUMMARY

€ INFORMATION AND WARNINGS
@ Initia Correspondence Points
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H A Check CalibreLVS Summary
H OVERALL COMPAISON RESULTS

OVERALL COMPARISON RESULTS

# o IHHHRA AR AR
# # # x =
# # # CORRECT # |

# # # # 0\

# HHHBRHHHHHH A
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H A Check CalibreLVS Summary
km/ CELL SUMMARY

khkkhkkhkhkhkkhkkhkkhkhkhhhhhkhkkhkkhkhhhhhkhkkhkhkhkhhhhkhkhkkhkhkhkhhkkkkkikkk*k*x%

CELL SUMMARY

ER Rt dh i b b S S S Sb S 4 b b b S e S S b i b b S S S S S i b b b S S S S b (i (b S S S S S 4 b b

CORRECT CHIP CHIP
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@ Check CalibreLVS Summary

el INFORMATION AND WARNINGS

kkhkkkhkkkkkkhkkhkhkhkhkhkhkhhkhkhkhkhkhkhkhkhhkhhkhkhhkhkhhkkhkhkhkkhkhhkhkhkhkkhkkkhkhkkhkkhkkkkhkhkkkhkkkkkk*x*

INFORMATIONANDWARNINGS

kkhkkkkkkkkhkkhkkhkhkhkhkhkhkhhkhkhkhkhkhhkhkhhkhhhkhkhkhkhhkhkhkhkhkhhkhkhkhkkhkhkkhkkhhkkhkkhkkkkhkhkkkhkkkkkk*kx

Matched Matched Unmatched Unmatched Component

Layout Source Layout Source Type
Nets: 11525 11525 0 0
Instances: 1 1 0 0 ADDFHX1
54 54 0 0 ADDFHX4
79 79 0 0 ADDFX2
542 542 0 0 AND2X1
8 8 0 XOR3X2

Total Inst: 10682 10682 0 0



7\ Check CalibreLVS Summary

s CIC)
|

{

Initial Correspondence Points

o Initial Correspondence Points:

Netss DVDD VDD DGND GND |_X[2] |_X[3] |_X[4]
| X[5] 1 X[6] | X[7] | _X[8] | X[9] | X[10] | X[11]

O SCAN OUT O Z[0] O Z[1] O Z[2] O Z[3] | HALT
| RESET | DoDCT | RamBistE| CLK | SCAN_IN

| SCAN_EN | X[0] O Z[4] | _X[1] O Z[5] O Z[6]

O 7[7] O z[8] O Z[9] O Z[10] O Z[1]]
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i’ Check CalibreLVSLog

€& TEXT OBJECT FOR CONNECTIVITY EXTRACTION
& PORTS
& Extraction Errors and Warnings for cell “CHIP”

156



HER Check CalibreLVSLog
::hrr/TEXT OBJECT FOR CONNECTIVITY EXTRACTION

i
L
T

O _Z[0] (523.447,31.68) 105 CHIP  O_Z[1] (598.068,31.68) 105 CHIP

O 7[2] (821.931,31.68) 105 CHIP  O_Z[3] (896.553,31.68) 105 CHIP

O 7[4] (971.175,31.68) 105 CHIP  O_Z[5] (1164.455,372.964) 105 CHIP

O _Z[6] (1164.455,446.966) 105 CHIP  O_Z[7] (1164.455,520.968) 105 CHIP
O_Z[8] (1164.455,594.97) 105 CHIP  O_Z[9] (1164.455,668.972) 105 CHIP
O_Z[10] (1164.455,742.974) 105 CHIP O _Z[11] (1164.455,816.976) 105 CHIP
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c10) Check CalibreLVSLog

==fo(“:‘=
oL PORTS

PORTS
O _Z[0] (523.447,31.68) 105 CHIP O Z[1] (598.068,31.68) 105 CHIP
O 7Z[2] (821.931,31.68) 105 CHIP O Z[3] (896.553,31.68) 105 CHIP
O Z[4] (971.175,31.68) 105 CHIP O Z[5] (1164.455,372.964) 105 CHIP
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:(CIC) Check CalibreLVSLog
ey Extraction Errorsand Warnings for cdl “CHIP”

e —

Extraction Errors and Warnings for cell "CHIP"

WARNING: Short circuit - Different names on one net:
Net Id: 18
(1) name "GND" at location (330.301,216.95) onlayer 102"M2 TEXT"
(2) name "GND" at location (673.2,29.1) onlayer 101"M1 TEXT"
(3) name "VDD" atlocation (748.1,31.5) onlayer 101"M1 TEXT"
(4) name "VDD" at location (208.93,274.56) onlayer 101"M1 TEXT"
The name"VDD" was assigned to the net.
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Chapter 3

Post-L ayout Timing Analysis
-- Nanosim



=“YWhat Introduce After Place& Route?

NLiiin
Lo L
e

€ | nterconnection wire'sparasitic capacitance.

M1 to substrate

M2 L capacitance
Mlto M1
M1 4{ }7 capacitance
i M1lto M2
capacitance
vdd! l vdd! | |
T E

Ai

gnd! gnd! 161



CfC

‘--’W hat I ntroduce After Place& Route?

III_I-'I
‘13-._"""'?_

€ Interconnectionwires’ parasiticres stance.

M2 M1 parasitic resistance

A

M1 VIA parasiticresistance

vdd| I ‘vdd'

gnd! gnd!
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Illll

--ﬁf/PreL ayout And Post-Layout Design

& A pre-layout design (before P& R) and a post-layout design
(after P&R)

— e
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Illll

‘E'IE/ Why Post-L ayout Simulation?

clock skew
— W
I I
4% o J_WL criti:cal pathldelay
Iz
B e D DI Do =
Ly T )
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=2(10)
-

Illll
_.-_-..._-....

Gate-level
Netlist

Gate-level
Analysis

Post-layout Timing Analysis Flow

PN

Tr. Netlist
RC Network

RC Network

Tr-level
Analysis

Delay
Calculation

A
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52(CIC) . . .
sa’ Transistor -level Post-layout Simulation

TRiin
o

: layout ;

netlist/parasitic Cdlibre LPE/PRE
extraction

SPICE netlist
simulation Post-layout Nanosim
pattern simulation
simulation
result
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4

N What is Nanosim

i
L L

.

€ Nanosim is a transistor- level timing simulation tool
for digital and mixed signal CMOS and BICMOS
designs.

€ Nanosim handles voltage simulation and timing
check.

€ Simulation is event driven, targeting between SPICE
( circuit simulator ) and Verilog ( logic simulator ).
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=:7010) . .
=§_§?Preparefor Post-L ayout Simulation

@ Apply for aCIC account
» http://lwww.cic.org.tw = :
» fill in your persond data and your request.

€ Install identd program

» thisprogram is used to identify yourself when you log into CIC’s
account from remote machine.

€ Put your DB fileto CIC’saccount

168



..{H’ = §

N Replace Layout / L PE

HER
i
T —

®Qentry

—M  {LPE}

—tech {UMC18 | TSMC18 | TSMC25 | TSMC35}

—F GDSII

—T Top_cell _name

—s Ram_spce_fTi1lename

—t {ralsd | ralsh | ra2sd | ra2sh | rf2sh |
tl8ralsh | tl8ra2sh | tl18rflsh | tl18rf2sh | tl8rodsh|
18ralsh_1 | 18ralsh_2 | 18ra2sh}

—c {UMC18 | TSMC18 | TSMC25 | TSMC35}

—1 {UMC18 | TSMC18 | TSMC25 | TSMC35}

—0 Netlist _file name

€ Example:
»Qentry M LPE —tech UMC18 —f CHIP.gds —T CHIP
—Ss RAM1l.spec —t 18ra2sh —s RAM2.spec -t 18ralsh 1
—s RAM3.spec —t 18ralsh_2 —-c UMC18 —i UMC18 —o CHIP.netlist

€ Use gstat to check the status of your job.
& Thereallt is stored in “result_# directory.
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i Replace/L PE

¢ OUTPUT
» output netlist
» TOP_CELL.NAME
» nodename
» gpice.header
» nanosim.run
> logfilesfor strem in, stream out, Ipe
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23(CIC) : -
£’ Running Nanosim

€ Qentr
“M  {NANOSIM}

—nspice  CHIP.netlist spiceheader
—nvec CHIP.vec

—m Top_cell name
—c {CHIP.cfg}

—0 Output_file name
—out fsdb

—t Total _simulation time
¢ Example:

»Qentry —M NANOSIM —nspice CHIP.netlist spice.header —nvec
CHIP.vec —m CHIP —c CHIP.cfg —zCHIP.tech.z—o UM C18 —t 100

@ Use Qstat to check the status of your job.

€ Thereault is stored in “result_#” directory.
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b Spice Header File

@ Spice Header File > Modify PVT
> .1ib "118ul8v.012" L18U BJD
> _lib "118ul8v.012" L18U18V_TT
» _lib "118u33v_g2.011" 118u33v_tt

» *epic tech="voltage 3.3
» *epic tech=""temperature 100"
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CIC) . . .
i’ Generate Nanosim Simulation Pattern

€ | nput simul ation pattern --- vec format

type vec

time
radix
10
high 3.3
low 0.0
25
50
75

signal CLOCK,START, IN[7:0]
clock start

1
i

=

1
i

o

o o

IN<7:0>
44
i

XX
XX
XX
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2:(CIC) . _
=2’ Generate Nanosim Simulation Pattern

€ |nput simul ation pattern --- nsvt format

type nsvt
signal CLOCK,START,IN[7:0]
; clock start in[7:0]
radix 1 1 44
10 i i i
period 25
high 3.3
flow 0.0
0 0] XX
1 0 XX
0 0] XX
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==CIC) , , _
s’ Generate Nanosim Simulation Pattern

FRiin
oL,
-._-.. —

€ Y ou can generate Nanosim simulation patternfrom
Verlog-XL stimulus.

Verilog test bench file

integer outf;
initial begin
outf = S$fopen(input.dat');
$fclose(outf);
$finish;
end

always @(sys _clock or start or in)
$fdisplay(outf,”%t %b %b %h",$time,sys clock,start,in);
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25(CIC) . . . .
i’ Nanosim Configuration File

. =

Example Nanosm configuration file
bus_notation [ : ]
print_node logic ADRS[O]
print_node logic CLK
print_node logic DATA[O]

report_node power VD
set _node gnd DGND
set node gnd GND

set node v DVDD 3.3
set node v VDD 1.8

\ nodenamefile

ADRS[O]
ADRS[1]
CLK
DATA[O]




=a’ \V/1@W Simulation Result --- nWave

FRiin
-:-._-.. —

€ NOVASnWave

» awaveform viewer which support Timemill output waveform
format.

€ Environment setup

unix% source /usr/debussy/CIC/debussy.csh

€ Starting nWave

unix% nWave &
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e’ | oad Simulation Result --- nWave

MLy
uﬁ.:*
e =—=

Fie| Signal View Waveform Ansicg Tools 'Window Help
= - 0

Cipar

Hisrarchy elmier

Reslore Sograd
s By

Ratlora By
Convert lo Fasl File
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8] persifec et
'-Ip:-m‘mn-ﬂ-n
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] simicap

a1 simhist
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Select Signals --- nWave

Gl Sagnals
Ged All Signals

S ]

f Sgnat ]
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=’ Check Simulation Result --- nWave

AN
LAD LT
T,

<n'Wavemn Wave: 1= /n
File Signal ‘iew ‘Waveform Analog Tools Window Help

B s J)zrs 2 Z2W[By <> xins
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o Power Analysis Result

TRdin
Lo e
T g

€ The power analysisresult is stored in Nanosm simul ation

log (xxx.log) file

Current information
0.00000e+00 -

Node: VDD
Average current
RMS current

Current peak #1
Current peak #2
Current peak #3
Current peak #4
Current peak #5

calculated over the iIntervals:

1.00010e+03 ns

- -3.53355e+05 uA
3.53388e+05 uA

: -4.54061e+05 uA at
: -4.34973e+05 uA at
: -3.88048e+05 uA at
: -3.87280e+05 uA at
: -3.84302e+05 uA at

OFRLNP~O

. 78400e+02 ns
.00000e-01 ns
-.59000e+01 ns
.27500e+02 ns
.77800e+02 ns
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